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SUMMARY

Membrane fission is an essential process in all domains of life. The underlying
mechanisms remain poorly understood in bacteria, partly because suitable as-
says are lacking. Here, we describe an assay to detect membrane fission during
endospore formation in single Bacillus subtilis cells with a temporal resolution
of �1 min. Other cellular processes can be quantified and temporally aligned
to the membrane fission event in individual cells, revealing correlations and
causal relationships.
For complete details on the use and execution of this protocol, please refer to
Landajuela et al.1
BEFORE YOU BEGIN

This protocol allows the detection of membrane fission during endospore formation in single B. sub-

tilis cells with high temporal resolution. Other processes quantified in the same cell can then be

temporally aligned to the time of membrane fission.

Endospore-forming bacteria such as B. subtilis survive starvation and other stresses by forming

dormant spores that are highly resistant to harsh environmental conditions. The first morphological

transformation during sporulation is an asymmetric division that produces a larger mother cell (MC)

and a smaller forespore (FS) (Figure 1). The MC membranes then engulf the FS, driven by cell wall

remodeling.2 When the MC has nearly completed engulfing the FS, only a thin neck/tube connects

the engulfing membrane surrounding the FS to the MC membrane. Fission of this membrane re-

leases the FS, now surrounded by two membranes, into the MC cytoplasm. The MC then nurtures

the FS to become a mature spore. The membrane fission assay reported here relies on lipophilic

styryl dyes such as FM4-64 that are cell-impermeable. The dye partitions reversibly between the

aqueous medium (where it is very dim) and the cell membrane (where it is much brighter). Because

of the exchange with the dye in the media, photobleached dyes in the membrane are continuously

replaced by unbleached ones from the surrounding medium. This exchange maintains the fluores-

cence signal of the membranes relatively stable. More precisely, the stability of the fluorescence

signal from the membrane depends on the relative rates of photo-bleaching of the membrane-in-

serted dyes compared to the rate at which bleached membrane-bound dyes are replaced with
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Figure 1. Membrane fission during B. subtilis endospore formation

(A) Schematic of sporulation stages. Upon starvation, an asymmetric division produces a larger mother cell (MC) and a

smaller forespore (FS). The MC then engulfs the FS. At the end of engulfment, a thin neck or tube connects the

engulfment membrane to the rest of the MCmembrane (red box). Fission of the neck releases the FS, now surrounded

by two membranes, into the MC cytoplasm. Upon maturation, the FS turns into a spore, and the MC lyses to release it.

(B) The membrane fission step this protocol is designed to detect. i: before fission; ii: after fission.
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unbleached ones from the surrounding medium. Before the MC membrane fully engulfs the FS and

membrane fission occurs, dyes from the bath have access to the space between the forespore and

engulfingmembranes (separated by�20 nm2), and can therefore label thesemembranes in addition

to the MC membranes (Figure 1Bi and Figure 2A, left). However, after membrane fission, the inter-

membrane space around the forespore becomes isolated, and bleached dyes can no longer be re-

placed by unbleached ones from the bath, as the dye cannot cross membranes (Figure 1Bii and 2A,

right). This results in a much faster decay of the fluorescence intensity of the forespore and engulfing

membranes upon membrane fission. A related method for detecting the time of fusion pore closure

during exocytosis in endocrine cells is well established.3

The ability tomonitor the timing ofmembrane fission in single cells and correlate it with other cellular

processes is an important improvement upon a previous assay developed by Pogliano and col-

leagues.4 In the Pogliano assay, aliquots from a suspension of sporulating cells are taken at different

time points after the nutrient downshift, labeled with a lipophilic dye, then placed on an agarose

pad, and imaged. The dye has access to, and labels, the forespore and engulfingmembranes in cells

that have not yet undergone membrane fission. By contrast, only the outer MC membranes are

labeled in cells that have successfully undergone membrane fission. As cells enter sporulation at

different times and subsequent stages progress at varying speeds, observing a population of cells

provides only a snapshot, and the exact temporal relationship between quantities averaged over

cells is not known.
Preparation of rich casein hydrolysate medium (CH medium) for growing B. subtilis

Timing: 5 min

Note: The CHmedium is a complete medium that is used to sustain the growth of B. subtilis in

a laboratory environment.

Prepare complete CH medium using the individual components (see materials and equipment). For

100 mL, combine 94 mL of CHI + II, 4 mL of CH III, 1 mL of CH IV, and 1 mL of CH V in a sterile bottle.

Keep at room temperature (RT).
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Figure 2. Principle of the membrane fission assay

(A) Schematic showing how the timing of membrane fission is detected in time-lapse movies of individual cells. The

dye FM4-64 (depicted as a stars) is non-fluorescent in the surrounding media (white stars) becomes highly fluorescent

upon insertion into the membrane (yellow stars) . The lipid-inserted and free dyes exchange continuously, maintaining

a relatively stable labeling of the membranes prior to membrane fission (pre-fission), because bleached dyes (gray

stars) can exchange with a large reservoir of unbleached ones from the medium (white stars). Upon fission, unbleached

dyes in the bath medium (white stars) have no longer access to the inter-membrane space, leading to the onset of a

rapid decay in the intensity of the membranes surrounding the forespore (post-fission).

(B) The diagram shows how the fluorescence in the forespore membrane is expected to decrease over time as fission

occurs.
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Preparation of the nutrient-poor resuspension medium to initiate sporulation

Timing: 5 min

Note: When resuspended in this medium lacking essential nutrients, B. subtilis cells enter

sporulation to survive.

Prepare a complete sporulation resuspension medium using the individual components (see mate-

rials and equipment). For 50 mL, combine 50 mL Solution A, 2 mL Solution B, 2 mL Solution C, 2 mL

Solution D, 2 mL Solution E, and 42 mL Milli-Q water in a sterile bottle. Keep at room tempera-

ture (RT).
Preparation of agarose pads for imaging

Timing: 1 h

Imaging bacteria can be challenging due to their small size, non-adherent nature, and motility. The

use of agarose pads to immobilize live bacteria during imaging can help overcome these challenges

and enable microscopy experiments. Additionally, agarose pads do not impede the access of cells

to dyes and other small compounds, making them a versatile tool for bacterial imaging. In this pro-

tocol, agarose pads are prepared using gene frames (Thermo-Fisher; Ref AB0578, 1.7 3 2.8 cm);

however, alternative, more cost-effective methods for making agarose pads exist.5–7

CRITICAL: It is important to prepare the agarose pads only 2–5 min before harvesting the
cells. While you can make the agarose pads up to 1–2 h in advance, they must be stored in a
STAR Protocols 5, 102965, June 21, 2024 3
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humid chamber to prevent them from drying out. Drying of the pads can lead to osmotic

shock on the cells.
1. Clean two regular 1 mm thick microscope glass slides with 70% ethanol and water. Use Kimwipes

to completely dry the glass slide.

2. Take a gene frame (Thermo-Fisher; 1.73 2.8 cm) and carefully remove one of the plastic foils from

the gene frame without causing disassembly of the plastic cover on the other side of the gene

frame.

3. Attach the gene frame in the middle of one of the glass slides by first facilitating contact on just

one side, followed by guided attachment of the remaining gene frame with a fingernail.

4. Use amicrowave to dissolve 100mg (1%) of high-resolution low-melting agarose (Sigma) in 10mL

complete sporulation resuspensionmedium supplemented with 0.5 mg/mL FM4-64 (N-(3-Triethy-

lammoniumpropyl)-4-(6-(4-(Diethylamino) Phenyl) Hexatrienyl) Pyridinium Dibromide). Please,

refer to before you begin> FM4-64 stock solution.

CRITICAL: The agarose needs to be fully dissolved to obtain the minimal background
required for the microscopy experiments. To avoid boiling over of agarose, the agarose

solution should be heated in the microwave in 30-second pulses over 1–2 min. After

each pulse, gently swirl the bottle to ensure thorough mixing until the agarose is

completely melted. Caution should be exercised to prevent any burns.
5. Pipette 500 mL of the hot agarose-FM4-64 to the middle of the gene frame. Make sure the whole

area is fully covered.

CRITICAL: This solution is viscous. To prevent air bubbles and facilitate transfer cut the tip
of the pipette, pipette slowly, and avoid pipetting the whole volume of molten agarose.
CRITICAL: Try to avoid air bubbles by pipetting slowly.

6. Place the second glass slide on top of the sporulation-agarose-filled gene frame.

CRITICAL: Try to avoid air bubbles by pushing them down slightly onto the gene frame.

FM4-64 stock solution

To prepare a stock solution of FM4-64, dissolve one vial containing 100 mg of FM4-64 (Thermo Fisher

T13320) in 100 mL of Milli-Q water. This will give you a stock solution with a concentration of 1000 mg/

mL. Store the stock solution at 4�C.

KEY RESOURCES TABLE
REAGENT or RESOURCE SOURCE IDENTIFIER

Chemicals, peptides, and recombinant proteins

Molecular grade agarose Promega V2111

Acid hydrolyzed casein Neogene NCM0239A

FM4-64 Thermo Fisher Scientific T13320

Gene frames Thermo Fisher Scientific AB0578

Experimental models: Organisms/strains

Bacillus subtilis PY79 Prototrophic derivative
of B. subtilis 168

Tax. ID:1415167
Schindelin et al.8

Software and algorithms

Fiji Schindelin et al.8 https://imagej.net/software/fiji/

(Continued on next page)
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Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

JFilament Smith et al.9 http://athena.physics.
lehigh.edu/jfilament/

MATLAB MathWorks, Inc., Natick, MA https://www.mathworks.com/
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MATERIALS AND EQUIPMENT

Media components are prepared in Milli-Q water unless otherwise stated. Where indicated, liquid

media are sterilized by autoclaving for 30 min in the liquid cycle, or by filtering through a 0.22-mm sy-

ringe-driven filter or a bottle-top filter. Glassware is sterilized by autoclaving for 30 min in a dry cycle.

Sterilemedia components and glassware are stored at room temperature unless otherwise specified.

Equipment and media for the growth of B. Subtilis

Regular LB agar plates, or plates containing one of the following antibiotics if needed: 5 mg/mL

chloramphenicol; 1 mg/mL erythromycin plus 25 mg/mL lincomycin (MLS); 10 mg/mL kanamycin;

0.4 mg/mL phleomycin; 100 mg/mL spectinomycin; 10 mg/mL tetracycline.

CRITICAL: Plates can be stored at 4�C for up to 3 months. Tetracycline plates should be
protected from light.
Equipment

� Media and Glass culture tubes (18 mm3 150mm, VWR 47729–583) autoclaved; and roller drum in

a temperature-controlled incubator.

Alternatives: Similar tubes or rolling/shaking systems can be used to grow 5 mL of liquid cul-

ture with aeration.

CRITICAL: To ensure adequate aeration, the volume of the medium used should not be
more than 1/10th of the volume of the tube. In 18 3 150 mm tubes we use a maximum

of 5 mL of medium.
� 250 mL baffled flasks, autoclaved.

� Temperature-controlled shaking water bath that can accommodate 250 mL flask.

Alternatives: Temperature-controlled air-shakers can be used.

� Spectrophotometer to monitor optical density (OD600nm).

Defined rich casein hydrolysate medium (CH medium) components CHI+II, CHIII, CHIV, and

CHV

CH medium component CH I + II
CH medium component CH I + II

Reagent Final concentration Amount

Acid Hydrolyzed Casein 10 g/L 20 g

L -glutamate sodium salt monohydrate 4.70 g/L 9.4 g

L-asparagine monohydrate 1.60 g /L 3.2 g

L-alanine 1.25 g/L 2.5 g

Potassium phosphate monobasic anhydrous (KH2PO4) 1.36 g/L 2.72 g

Ammonium chloride (NH4Cl) 1.34 g/L 2.68 g

(Continued on next page)
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Continued

CH medium component CH I + II

Reagent Final concentration Amount

Sodium sulfate (Na2SO4) 0.55 g/L 1 mL (2000X stock)

Ammonium nitrate (NH4NO3) 0.50 g/L 1 mL (2000x stock)

Ferric chloride 6-hydrate (FeCl3$6H2O) 0.005 g/L 1 mL (2000x stock)

Total N/A 2 L
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With the final solution:

� Adjust pH to pH 7.0 with 1 N NaOH (�12.5 mL for 2 L).

� Dispense into 100 mL aliquots (in 125 mL bottles).

� Autoclave liquid cycle (30 min).

� Keep at RT.

CH medium component CH III (final volume: 1 L)

Timing: 15 min + 30 min autoclave

� Add 0.66 g/L calcium chloride dehydrate (CaCl2 $2H2O), and 1.21 g/L magnesium sulfate anhy-

drous (MgSO4) to 1 L Milli-Q water).

CRITICAL: Dissolution of anhydrous MgSO4 is exothermic (the beaker may warm up).

� Dispense into 100 mL aliquots (in 125 mL glass bottles).

� Autoclave liquid cycle (30 min).

� Can be kept at RT for 3 months.

CH medium component CH IV (final volume 1 L)

Timing: 15 min + 30 min autoclave

� Add 1.67 g/L Manganese sulfate monohydrate (MnSO4$H2O) to 1 L Milli-Q water).

� Dispense into 100 mL aliquots (in 125 mL glass bottles).

� Autoclave liquid cycle (30 min).

� Can be kept at RT for 3 months.

CH medium component CH V (final volume 100 mL)

Timing: 30 min

� Add 2 mg/mL L-Tryptophan to 100 mL Milli-Q water.

� Filter-sterilize using a screw cap 0.22 mm filter.

� Dispense into 10 mL aliquots (in 15 mL conical plastic tubes).

� Store in a rack in the cold room for a maximum of 3 months.
Equipment and media for visualizing B. Subtilis synchronous sporulation using time-lapse

microscopy

Equipment

� Bench top centrifuge for spinning 50 mL conical tubes. Sporulation agarose pads (see before you

begin>preparation of agarose pads for imaging).
6 STAR Protocols 5, 102965, June 21, 2024
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� Bench top centrifuge for spinning 50 mL conical tubes.

� A wide-field fluorescence microscope outfitted with a high magnification, high numerical aper-

ture objective and a sensitive camera. We used a Leica DMi8 wide-field inverted microscope

(Leica USA, Buffalo Grove, IL) equipped with a Leica HC PL APO 1003 DIC oil immersion

objective (NA = 1.44; Leica TypeF immersion oil) and a Leica LED beam assisted Adaptive

Focus System (AFS). Images were captured by a 16-bit 1024 3 1024 pixel, 16-bit EMCCD

iXon Ultra camera (Andor Technology, Belfast, Northern Ireland), using 50–100 ms exposure

per frame at 5%–10% light intensity, and EM amplifier gain set to 300. A Spectra X light engine

(Lumencor Inc., Beaverton, OR) served as the light source. The effective pixel size corre-

sponded to 130 nm. The Leica Application Suite X (LAS X) controlled the system, while analysis

and processing were carried out using Fiji.8 FM4-64 excitation was accomplished using the

575/25 nm band of the SpectraX system, with a long-pass emission filter (lem > 610 nm)

from chroma ET610lp. Humidified stage-top incubator to prevent the agarose pad from drying

(TC-MIS; Bioscience Tools).

Alternatives: Other humidified, temperature- controlled environmental chambers for micro-

scopes can be used.

Sporulation resuspension medium components A, B, C, D, and E

Solution A (final volume 1 L)

Timing: 30 min

� Add 0.089 g/L ferric chloride 6-hydrate (FeCl3$6H2O), 0.83 g/L magnesium chloride hexahydrate

(MgCl2$6H2O), 1.98 g/L manganese chloride tetrahydrate (MnCl2$4H2O) to 1 L Milli-Q water).

� Dispense into 10 mL aliquots (in 15 mL conical tubes).

� Wrap with foil. Can be stored at 4�C for up to 3 months.

Solution B

Timing: 1 h + 30 min autoclave

� Mix:
Solution B

Reagent Final concentration Amount

Ammonium chloride (NH4Cl) 13.4 g/L 26.8 g

Sodium sulfate (Na2SO4) 2.65 g/L 5.3 g

Ammonium nitrate (NH4NO3), 2.43 g/L 4.86 g

Potassium phosphate monobasic anhydrous (KH2PO4) 1.70 g/L 3.4 g

Total N/A 2 L
� Dissolve in 80% volume (1600 mL), adjust to pH 7.0 using 1 N NaOH, add Milli-Q water to final

volume.

� Autoclave liquid cycle (30 min).

� Can be kept at RT for up to 3 months.

Solution C (final volume 1 L)

Timing: 1 h + 30 min autoclave
STAR Protocols 5, 102965, June 21, 2024 7
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� Add 63.6 g/L L-glutamic acid sodium salt monohydrate to 1 L Milli-Q water.

� Autoclave liquid cycle (30 min).

� Can be kept at RT for 3 months.

Solution D (final volume 1 L)

Timing: 1 h + 30 min autoclave

� Add 3.68 g/L calcium chloride dehydrate (CaCl2$2H2O) to 1 L Milli-Q water.

� Autoclave liquid cycle (30 min).

� Can be kept at RT for 3 months.

Solution E (final volume 1 L)

Timing: 1 h + 30 min autoclave

� Add 120.4 g/L magnesium sulfate anhydrous (MgSO4) to 1 L Milli-Q water.

CRITICAL: Slowly add the MgSO4. Dissolution of anhydrous MgSO4 is exothermic (the
beaker will get hot).
� Dispense into 100 mL aliquots (in 125 mL bottles).

� Autoclave liquid cycle (30 min).

� Can be kept at RT for 3 months.
Image analysis

� Fiji: https://www.lehigh.edu/�div206/jfilament/download.html#current.

� MATLAB: https://www.mathworks.com/products/matlab.html.
STEP-BY-STEP METHOD DETAILS

Days 1–2: Exponential growth of cells

Timing: 2 days

Note: The purpose of this step is to ensure that the bacterial culture reaches themid-exponen-

tial phase by the following morning.

1. Streak out the B. subtilis strain of interest on an LB agar plate containing the appropriate antibi-

otics and incubate at 37�C overnight. Use a different temperature if the strain has a specific

requirement.

CRITICAL: Streak out strains freshly for every experiment.

2. Next morning, if the colonies are visible take the plate out and leave at room temperature during

the day to prevent overgrowth.

CRITICAL: Do not leave the plates at 4�C. B. subtilis cells die on the plates at 4�C.

3. Set-up a starter culture by inoculating a single colony into an 18 3 150 mm tube containing 5 mL

complete CH medium, vortex gently to disperse the colony. This is tube 1.
8 STAR Protocols 5, 102965, June 21, 2024
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CRITICAL: B. subtilis tends to clump in the colony. Vortex gently for 5 sec to make a ho-
mogenous inoculum. Also make sure to use no more than 5 mL of medium to guarantee

proper aeration.
4. Make a 1–5 dilution of the inoculum by transferring 1 mL of the inoculum into 4 mL of fresh me-

dium. This is tube 2.

5. Make another 1–5 dilution by transferring 1 mL from Tube 2 into 4 mL of fresh medium. This is

tube 3.

6. Put the three tubes in a roller drum and roll overnight at 22�C.
Day 3: Time-lapse microscopy of sporulating cells

Timing: 1 day

Note: Synchronous sporulation is induced in liquid medium at 37�C by resuspension in min-

imal salts according to the method of Sterlini-Mandelstam.10

7. The next morning, measure the optical density (OD600nm) of the three cultures and use the culture

that is between 0.4 and 0.6. Dilute the culture in 25 mL of complete CH medium prepared the

previous day (see before you begin) in a 250 mL baffled flask to an OD600nm of 0.05.

CRITICAL: To ensure adequate aeration, the volume of the medium used should not be
more than 1/10th of the volume of the flask. In 250 mL baffled flask you should not use

more than 25 mL of medium.
8. Put the flask in the shaking water bath and shake at 250 rpm at 37�C (or other desired

temperature).

Alternatives: Other temperature-controlled air-shakers can be used.

9. While the cells are growing prepare 100 mL of sporulation resuspension medium in a sterile bot-

tle (See before you begin).

10. When the culture reaches an OD600nm of 0.5, transfer all the cells from the flask (about 20–25 mL)

into a 50 mL conical tube by pouring. Save the empty flask.

CRITICAL: Make sure there is no liquid left in the flask by flipping it over on a paper towel
to let all the liquid run down.
11. Spin the tube in a bench-top centrifuge at 5000 3 g for 5 min. Remove the supernatant by

aspiration.

CRITICAL: The cell pellet is not tight. Try to remove as much medium as possible without
losing cells.
12. Add 20 mL of sporulation resuspension medium (from step 3) to the cell pellet. Pipette to resus-

pend and transfer the cells back to the original flask (from step 4). Put the flask back to the

shaking water bath at 37�C This is time = 0 h, or T0.

13. 1 h after T0, add FM4-64 (0.5 mg/mL) to the culture and continue incubating at 37�C for another

h. The end of this period is marked T1.

CRITICAL: Do not add more than 0.5 mg/mL FM4-64. Higher concentrations will affect cell
viability over time.
STAR Protocols 5, 102965, June 21, 2024 9
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14. Next, prepare the stage-top incubator for imaging.

CRITICAL: Carefully fill the water reservoir to maintain high humidity in the incubator. This
is to prevent the agarose pad from drying out. Turn on the stage top incubator and objec-

tive heater and allow them to reach and stabilize at the required temperature, which takes

about 30 min.
15. 1 h after T1, take the sporulating culture from the water bath. Time elapsed since nutrient down-

shift is now 2 h, or T2.

16. Carefully slide off the upper glass slide from the previously prepared agarose pads (See before

you begin). Use a razor blade or disposable scalpel to cut out agarose strips of �5 mm width

within the gene frame, on which the cells will be deposited. A maximum of three strips can be

used per slide, separated by �4 mm space to either side. If the microscope stage allows multi-

position acquisition, multiple strains can be visualized simultaneously on the same slide, each

strain on a different strip.

CRITICAL: Be sure to dispose of sharps used for scoring the agarose in the sharps bin and
take care not to break fragile slides and cover slips. Broken glass cannot be recycled.
17. Load 20 mL of T2 cell culture for a whole strip. Always start on top of the agarose pad and allow

the liquid to disperse equally on its assigned growth area by turning the slide up and down. The

slide is ready as soon as the movement of the liquid is no longer visible when turning the slide.

(Normally this takes 2–3 min).

CRITICAL: If the coverslip is placed on the cells without allowing them to dry long enough,
cells are not appropriately immobilized, and they tend to grow on top of each other during

the experiment. At the same time be careful not to wait too long before applying the

coverslip, since the agarose will then be too dry.
18. Carefully remove the second and final plastic cover from the gene frame to expose the sticky

side of the gene frame.

19. Place a clean microscope slide coverslip (24 3 50 mm, #1.5, 0.17 mm thickness) on the gene

frame from one side to the other.

CRITICAL: Ensure complete attachment by applying pressure on the coverslip along the
gene frame with your fingernail.
20. Put the samples into the preheated stage top incubator, which should already be at 37�C de-

grees. Close the lid of the incubator.

CRITICAL: Incubate for 15–30 min before starting imaging to stabilize the temperature in
the pads.
21. Take picture every 5 min for at least 2 h using high magnification. In our case we use a 100x

objective (N.A. = 1.4) and 1 camera pixel corresponds to 130 nm in the imaging plane.

CRITICAL: To reduce image drift due to evaporation, chose a field of view that is not too
close to the edge of the agarose strip. Also, use a low excitation light intensity (in our case

5%) and short enough exposure time (100 ms) to minimize phototoxicity. Higher light in-

tensities and/or exposures times may dramatically compromise cell viability. The optimal

amount of light exposure should be determined empirically: it should be high enough to

get sufficient signal-to-noise for analysis (see below), but low enough not to cause cell

damage. Because high light exposure may be toxic in the presence of the FM dye, cell
10 STAR Protocols 5, 102965, June 21, 2024



Figure 3. Expected outcomes

(A and B) Expected outcomes of time-lapse microscopy of bacteria undergoing the process of sporulation. Figure 3A displays a snapshot image of a cell

field with an optimal density for analysis (10%–20% coverage). Scale bar is 10 mm. Orange arrows indicate cells that are in the asymmetric division stage.

In Figure 3B, single cells are cropped and positioned vertically, and their progression over time is documented in 5-min intervals. The bottom row

displays the same image as in the first row but using colors to indicate intensity (Fire LUT) for easier visualization. The scale bar represents 10 mm.
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viability must be checked and excitation intensity and/or exposure time may need to be

reduced accordingly. Cell death is easy to assess, as damaged cells lose contrast and even-

tually lyse: a sudden reduction in cell contrast is observed in the phase or DIC channel,

while the cell membrane collapses in the FM4-64 channel. Under our experimental condi-

tions, 100 ms exposure per frame at 5% light intensity was sufficient to collect 71 frames.
22. Once the imaging process is finished, save the time-lapse movies for subsequent analysis.

Note: You can find many useful tips for imaging Bacillus subtilis in Harwood and Cutting11 and

Wang and Montero Llopis.12
EXPECTED OUTCOMES

Images of cells undergoing sporulation and labeled with FM4-64 are captured over a period of 2–3 h

(1 frame every 5min, total number of frames = 71) at a temperature of 37�C. A snapshot from amovie

is shown in Figure 3A. Cells which complete engulfment during themovie are visually selected, crop-

ped and analyzed in detail. Sequential snapshots of three bacteria (indicated with arrowheads in Fig-

ure 3A) are cropped, rotated, and shown in Figure 3B (also see quantification and statistical analysis).

Using the image stacks, three parameters are quantified: 1) the spatial coordinates of the contours of

the labeled membranes surrounding the FS and 2) the MC (Figure 4) and 3) the intensity of the FS

contours (Figure 5).
STAR Protocols 5, 102965, June 21, 2024 11



Figure 4. Representative example of fitting a snake to a forespore in JFilament

The fitted snake appears as a red contour around the forespore.
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First, using an active contour or "snake" algorithm, themembranes delimiting theMC and the FS are

detected (Figure 4). Note that the MC contour is the outer contour of the cell, excluding the mem-

branes surrounding the FS (Figure 5A). These contours are then used to estimate the surface areas of

the FS and MC compartments through a revolution around the axis of symmetry of the cells. By

repeating the procedure for every frame, the time evolution of the surface areas in a given cell is esti-

mated (Figures 5C and 5D). The ‘‘snake’’ coordinates defining the FS contour are additionally used to

calculate the mean FS contour pixel intensity. As can be seen in Figure 3B, the FS contour intensity

starts decreasing at some point, indicating the FM4-64 dye can no longer exchange between the

bath and the space between the forespore and engulfment membranes, marking that membrane

fission has occurred. By cross correlating a model decay function to the FS contour intensity profile,

the time of membrane fission (just before the intensity started declining) can be determined within 1

frame (Figures 5A and 5B). Thus, for the same cell, both surface areas and the moment of membrane

fission can be determined.

It is important to note that to detect the time of fission we rely on a sudden increase in the rate of fluo-

rescence intensity decay of themembranes surrounding the forespore. The absolute values of the inten-

sities are not used to draw any conclusions and themethod is robust against slow continuous changes in

signal, and background correction. This can be seen from the examples shown in Figure 6. Snapshots of

FM4-64 fluorescence, taken at 5 min intervals, are shown for a cell, together with the FS (blue) and MC

contours (yellow) detected using JFilament.9 Fluorescence intensities, averaged over the 4 pixel-wide

membrane contours are shown as a function of time in Figure 6B for 4 separate examples. The average
12 STAR Protocols 5, 102965, June 21, 2024



Figure 5. Detection of membrane fission in single B. subtilis cells during endospore formation

(A) An example of a single cell, labeled with FM4-64, followed as a function of time. Top row shows a montage of FM4-64 fluorescence images as a

function of time. The bottom rows show the forespore contours (in blue) and MC contours (in yellow) detected using JFijament.9 Completion of the

engulfment phase (tengulf) and the frame preceding fission (tfiss) are indicated in the image with a green and red arrow, respectively. Bar, 1 mm.

(B) Plot of the mean FS contour FM4-64 fluorescence (black) as a function of time for the individual cell in B, displaying a relatively stable signal and a

rapid decay upon membrane fission. Cross -correlation of the fluorescence signal with a model decay function (blue) was used to determine tfiss.

(C) MC membrane area as a function of time for 25 cells. Error bars represent SEM.

(D) Like (C, D) but in the case the time axis was shifted for individual cells such that t = 0. The dashed blue and red lines are linear fits to the pre-fission and

post-fission periods. Error bars represent SEM.
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intensity in a 0.6 mm-by-2 mm box from a region away from cells is also shown as background (BK, in

green). Note that only the FS contour intensity displays a sharp onset of accelerated decay, consistent

with membrane fission. The slow, more steady decay of the MC intensity reflects competition between

photobleaching and the exchange of bleached and unbleached dyes between the cell membrane

(where the dye is brighter) and the surrounding medium (where the dye is dimmer). This exchange is

slowed by the cell wall. The background intensity also decreases slowly, due to photobleaching, as a

large area is illuminated for imaging. The second row in Figure 6B shows themeanFS contour intensities

on an expanded scale,with theonset of the rapid intensity decay (indicatedby a red star) detectedusing

a cross-correlation algorithm as described below (Figure 5B). The 3rd row shows the FS contour inten-

sities correctedby subtracting thebackground intensity values. The applicationof the algorithmdetects

the same onset of rapid-intensity decay. Thus, the approach is robust against steady slow changes in

intensities and is insensitive to background correction.

We note that in fact threemembranes contribute to themean FS contour pixel intensity whose decay

is analyzed: the FS membrane, the engulfment membrane, and the MC membrane. Because these

membranes are in proximity, we cannot resolve them. The accelerated fluorescence intensity decay

upon membrane fission occurs only in the first two membranes since the thin aqueous compartment

they face is cut off from the surrounding medium containing a reservoir of unbleached dye. The MC
STAR Protocols 5, 102965, June 21, 2024 13



Figure 6. The approach is robust against steady changes in intensities, such as due to photobleaching, and is insensitive to background correction

(A) Example of the fluorescence intensity changes for an individual cell as a function of time. The cell membranes are labeled with the lipophilic

fluorescent dye FM4 -64. Top row: snapshots of FM4-64 fluorescence, taken at 5 min intervals. The 2nd and 3rd rows indicate the FS (blue) and MC

contours (yellow) detected using JFilament9 superimposed onto the original images. The frame preceding membrane fission (tfiss), estimated from the

onset of a rapid decay in the FS contour intensity (see B), is indicated. Bar, 1 mm. The bottom row displays the same image as in the first row but using

colors to indicate intensity (Fire LUT) for easier visualization.

(B) Detection of the time of membrane fission from membrane contour intensity profiles. Each column shows measurements from a separate cell. The

top row shows the pixel intensity averaged for the entire contour (expanded to 4-pixels wide) for the FS (for contours shown as in A, 2nd row) and the MC

(for contours as in A, 3rd row). The average intensity in a 0.6 mm-by-2 mm box from a region away from cells is also shown as background (BK, in green).

Note that only the FS contour intensity displays a sharp onset of an accelerated decay, consistent with membrane fission. The second row shows the

mean FS contour intensities on an expanded scale, with the onset of the rapid intensity decay (indicated by a red star) detected using a cross-correlation

algorithm as described in text. The 3rd row shows the FS contour intensities corrected by subtracting the background intensity values. Application of

the same algorithm detects the same onset of rapid intensity decay. Thus, the approach is robust against steady changes in intensities, such as due to

photobleaching, and is insensitive to background correction.
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membrane’s intensity should decay more slowly, following the same kinetics as the rest of the MC

membranes. Thus, the decay of the mean FS contour pixel intensity upon membrane fission would

be even faster if the MC membrane did not contribute to the signal.
14 STAR Protocols 5, 102965, June 21, 2024
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When theMC surface areas of all cells are averaged and plotted as a function of time from the start of

the movie, a potentially interesting phenomenon emerges: the MC surface area declines slowly for

�90 min, then recovers slightly or remains stable (Figure 5C). Is there a relationship between MC

area and membrane fission? To answer this question, the area vs. time measurements in individual

cells were temporally aligned to the time of membrane fission detected from the FS contour intensity

changes in the same cells. The average MC area as a function of time with this new reference frame

clearly indicates the MC area decreases until membrane fission, then starts increasing slowly (Fig-

ure 5D). The decline is interpreted to be due to the MC membrane flowing into the membranes sur-

rounding the FS to support their growth, as the FS inflates during this time due DNA translocation

into the FS compartment by the ATPase SpoIIIE.1 This loss of MC membrane area occurs faster than

the rate at which new lipids can be synthesized and inserted into the MC membrane. After mem-

brane fission, the MC membrane area grows, because the membrane sink no longer exists, while

new lipid synthesis and insertion continues. Because membrane fission occurs at different times

for different cells, without precise information about the fission time for individual cells, these con-

clusions would be difficult to reach. Furthermore, because a single imaging channel (FM4-64) is used

to monitor membrane fission and membrane areas, other channels can in principle be used to

monitor other cellular processes that may be related to membrane fission and/or sporulation.

Although we used FM4-64, other dyes may be suitable, if the dye does not cross the membrane.

In addition, for each new dye, phototoxicity must be assessed.
QUANTIFICATION AND STATISTICAL ANALYSIS

This step describes the technical computer-based analysis of membrane fission during endospore

formation in single B. subtilis cells. The analysis not only detects when membrane fission occurs

but also measures the contour lengths of labeled membranes.

1. Download and install Fiji8 from https://imagej.net/software/fiji/

Note: Fiji is just ImageJ, with many popular plug-ins pre-installed).

2. Download JFilament9 at https://www.lehigh.edu/�div206/jfilament/download.html#current.

Note: See the tutorial at the JFilament website formore information about how to use JFilament.

CRITICAL: To run JFilament you need to have installed Java and Java3D.

3. Open your time-lapse movie in Fiji using File > Open command. Alternatively, drag and drop the

image file onto the Fiji toolbar.

4. Plugins > Registration > Manual drift correction.

Note: this is for correcting image drift.

5. Edit > Selection > Fit rectangle. Select (square selection) a cell which has enter sporulation and is

in the asymmetric division/early engulfment step (Figures 2 and 3A).

6. Image > Duplicate > Duplicate Stack.

Alternative: This is only for simplification purposes. You can work with the whole field of view if

desired.

7. Image > Transform > Rotate.

Alternative: this is only for presentation purposes. You can work with the cells in their original

orientation.
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8. Image > Stack > Make montage.

Alternative: This is only for presentation purposes. You can work with the images in the stack

mode.

9. Plugins > JFilament > JFilament2D. Snakes are fitted to forespores using the FM4-64 membrane

stain. Fitting parameters are as follows: Curve type = contour, a = 100, b = 100, g = 800, weight =

0.5, stretch force = 100, deform iterations = 100, point spacing = 0.5, image smoothing = 1.01.

CRITICAL: Since we are using the closed contour function in JFilament you will only be able
to fit a snake after engulfment (tengulf) is completed.
Note: A representative example of fitting a snake to a forespore in JFilament is shown in Fig-

ure 4 through a screenshot.

10. Draw snakes for all forespores (FS) or mother cells (MC) in the image sequence and then in

JFilamenti snakesi save snakes. This save current snakes to be loaded again and used later.

The saved file is a .txt file with all the snake coordinates.

11. Open MATLAB https://www.mathworks.com/products/matlab.html and run sequentially the

following programs:
a. ReadSnakes.m.

Note: This reads files directly saved in step 10.

b. SnakeIntensity.m.

Note: This takes the snake coordinates (x, y) from 11.a and generates a mask (dilated to 4

pixels) to analyze the mean fluorescence intensity (FM4-64) along the FS contour.

Note: If a snake is fitted around a MC, the program will perform the same task.

c. xcorrfissiontime.m.

Note: This takes the intensity values calculated in 11.b and cross- correlates them with a tem-

plate function to determine the time of membrane fission. We expect the intensity to be

roughly constant and then decay exponentially after fission. Thus, we use a template function

that is a constant for 5 points, then decays exponentially for 15 points. Adjust decay rate (1/3

now) as needed. The program returns the rescaled data, the x-correlation values (r) and

the lags. The time point just before the exponential decay starts is themoment of fission (tfiss ),

indicated by a red cross.

d. Sporesize.m.

Note: this involves obtaining the snake coordinates (x, y) from 11.a, fitting an ellipse through

them, and generating a surface of revolution around the major axis of the ellipse that has been

fitted.

Note: If a snake is fitted around a MC, the program will perform the same task.

12. You can then go back and locate the time of fission (tfiss ) in your movie.

13. For figure generation or presentation purposes you can open in Fiji both the .tiff and .txt to

obtain an image with superimposed snakes.
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Note: For presentation purposes, you can change the color of the snakes using Adobe Photo-

shop or alternative.

LIMITATIONS

A significant challenge in conducting live-cell observations using lipophilic dyes is potential photo-

toxicity,13 which can greatly limit the duration of observation and the amount of dye that can be uti-

lized. To mitigate this, it is essential to employ a highly sensitive microscope setup, complete with

optimal filters and a high-sensitivity camera, such as an EMCCD. The presence and degree of photo-

toxicity can be determined by observing the effects on the cells, primarily cell death.

TROUBLESHOOTING

Problem 1

Related to day 3: time-lapse microscopy of sporulating cells.

High background fluorescence.

Potential solutions

� Consider opting for a commercially available agarose with higher purity and reduced background

fluorescence.

� Avoid boiling the agarose for extended periods of time. Boiling the agarose for too long can lead

to increased concentration of the dye and subsequent increased background fluorescence.

Problem 2

Related to day 3: time-lapse microscopy of sporulating cells.

The excessive movement of the bacteria hinders the experiment.

Potential solutions

� If you are not using one, try using a focus maintenance device.

� There might be areas near the edge of the agarose pad where the bacteria will be moving. Bac-

teria are more likely to be static towards the center of the pad.

� Increase agarose percentage in the pad to 1.5%–2%.

� Use the registration plugin in Fiji to correct for drift (see quantification and statistical analysis,

point 4).

Problem 3

Related to day 3: time-lapse microscopy of sporulating cells.

There is a significant amount of cell death occurring during imaging due to phototoxicity.13

Potential solutions

� Reduce the overall light exposure during imaging. This can be achieved by reducing the excitation

light intensity, the exposure time per frame, and/or the total number of frames acquired.

� It may be worth exploring the use of alternative dye, as they may have lower levels of

phototoxicity.

Problem 4

Related to quantification and statistical analysis.

The cells are so close together that it is difficult to pick individual ones for image analysis.
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ll
OPEN ACCESS Protocol
Potential solutions

� It is likely that the agarose pads are too dry. To prevent them from drying out, you can place them

in a humid chamber, such as a closed box with some wet napkins.

� It may be that the agarose concentration is too high. Reduce the concentration to 1%.
Problem 5

Related to quantification and statistical analysis.

JFilament gives you an error when fitting a snake to the forespore or mother cell membrane.
Potential solution

� Try lowering the ‘‘deform iteration’’ setting in the program. The program defaults to 100 but

reducing it often improves the fitting.
RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the lead contacts, Erdem Karatekin (erdem.karatekin@yale.edu) & Ane Landajuela (ane.

landajuela@yale.edu).
Technical contact

Further technical information should be directed to Ane Landajuela (ane.landajuela@yale.edu).
Materials availability

The materials related to this protocol are available upon request from the lead contact.
Data and code availability

MATLAB scripts generated for image analysis are available at Mendeley Data https://data.

mendeley.com/datasets/bkr62x86p8/1.
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